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How DEXembed and WordEmbed work, and 
why you might use them
Lucie Haskins
 
Lucie Haskins describes how the arrival of DEXembed and WordEmbed transformed her from ‘refusenik’ as far as 
embedded indexing in Word was concerned into someone who takes such projects in her stride. She explains what 
is difficult about the Word embedded indexing tool and how DEXembed and WordEmbed come to the rescue.

Indexing in a desktop publishing (DTP) package can take 
from 50  percent to 100  percent longer than back-of-the-
book (BOB) indexing, depending on the package (such 
as FrameMaker or InDesign). The reason is the limited 
features and functionality of the indexing modules 
included in these packages.
	 Fortunately indexing fee structures typically 
reflect that reality, and DTP indexing usually 
commands a higher rate. However, I found that 
did not hold true for embedded indexing in Micro-
soft Word, and as a result I always used to decline 
embedded Word projects. They just were not worth 
the hassle of fighting with inadequate tools to 
create an index and then not being compensated 
appropriately.
	 All that changed when WordEmbed and 
DEXembed came on the scene. To my mind, they 
revolutionized embedding indexes in Word. With 
these utilities, you can finally have the best of 
both worlds. You index in the proprietary indexing 
package of your choice (CINDEX, Macrex or Sky 
Index: C/M/S), then import your finished index into 
Word in one fell swoop! You never have to index 
in Word itself. Suddenly, the price structures have 
become equitable.
	 DEXembed1 and WordEmbed2 were both 
released around 2004, and I reviewed them the 
following year in a KeyWords article, ‘Digging in for 
the long haul’.3 I was blown away by their function-
ality, and a decade later I am still impressed with 
the sheer creativity of both utilities.

	 This article provides an overview of each utility’s func-
tionality. (For a more detailed explanation of each task and 
feature, download the instruction manual provided with 
each utility.)

   Figure 1 Embedding the index entries in Word
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•  no real-time previews of indexes
•  no autocomplete during data entry
•  no sophisticated formatting options
• � no powerful editing capabilities (such as 

cascading changes)
•  no temporary groupings.

Embedded indexing (regardless of the indexing 
package used) requires a two-step process. First 
the index entries must be embedded in the 
material (Figure 1). Then the index itself must 
be generated (Figures 2 and 3).

Step 1: Creating embedded index entries in Word

Embedding in Word involves using XE fields 
(see the XE ‘Drop Shadow box’ in Figure 1). 
Each index entry is created and embedded  
individually as an XE field. The steps are:

1	� Insert the cursor at the desired location to 
embed the index entry.

2	 Select the References tab.
3	 Select the Mark Entry option.
4	 The Mark Index Entry dialog box opens. Create the index 

entry within the dialog box.
5	 The XE field (index entry) is automatically inserted at the 

cursor location.

MS Word does not have any functionality to tie  index entries 
together. To edit an index entry, you first need to have the 
XE field visible. You can toggle the visibility with the Para-
graph symbol on the toolbar. Once the XE field (index 
entry) is visible, you can edit it. For cascading changes, you 
need to go to each index entry affected and manually edit 
each one separately, a very tedious process.

Step 2: Generating an index in MS Word

You can generate an MS Word index as a 
separate file or at the end of the current 
document. To generate the index at the end of 
a single document (see Figure 2):

1	� Position the cursor at the very end of the 
document.

2	 Open the References tab.
3	 Select the Insert Index option.
4	� In the Index dialog box, select the format 

options desired.
5	 Click OK to generate the index.

You can also generate the index in a separate 
file, which could be useful for multiple docu-
ments. The process is much more involved 
(see Figure 3):

1	 Create the new file (as a Word document).
2	 Open the Insert tab.
3	 Select the Quick Parts option.

	 To give a true appreciation of what DEXembed and 
WordEmbed accomplish, I first review Word’s native 
indexing module and its capabilities and limitations.

The embedding process in  
Microsoft Word 
Embedding index entries using Word alone is very time-
consuming and frustrating, because Word fails miserably in 
providing the very features that we indexers have come to 
rely on in our indexing software packages. It has:

Figure 2  Generating an index in Word

Figure 3  Generating a Word index in a separate file
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4		  Select Field from the dropdown box.
5		  The Field dialog box displays.
6		  From the Field names: section, select the RD field.
7		  Click on Field Codes (which turns into Hide Codes) and 

then click Options.
8	�	  The Field Options dialog box will identify supported 

switches for the Index field.
9		�  Select the switches desired, add the file name and  

extension in quotes, click Add Field, and click OK.
10		� Repeat steps 6–9 for each file to be included for 

indexing.
11	�	 Position cursor at end of the RD lines you created and 

follow the instructions for generating an index at the end 
of a single document.

Remember that the generated index only serves as a 
snapshot in time. If index entries are then modified or 
deleted, or if new index entries are later embedded, the 
generated index does not register these changes. You will 
need to manually regenerate the index to incorporate any 
modifications made after index generation.

The DEXembed and WordEmbed  
embedding process 
DEXembed and WordEmbed both import existing indexes 
into Word, but their approach in doing so differs.
	 Unlike with C/M/S there are not many screens to interact 
with, since most processing is done behind the scenes. The 
most noticeable difference between the two utilities is in 
how they interpret and work with locators. It will be a matter 

of individual preference which of the two utilities 
suits your work style best.
  The major steps are the same for both:

1	� Index as usual in C/M/S software using 
various locator options (DEXembed) or 
bookmark locators (WordEmbed).

2	� Save the index file for import as a tab- 
delimited file (DEXembed) or a RTF (CMS) 
or MBK file (WordEmbed).

3	� Import the index file into your Word 
document(s) and embed the index entries.

4	 Remove the temporary locators.
5	 Generate the MS Word index.

The next sections describe each step in the process,  
identifying the differences in each utility’s 
approach.

Step 1: Index as usual in C/M/S software using 
‘locators’

Because embedding an index entry means that 
the index record is actually inserted (embedded) 
into the document at a specific insertion point, 
DEXembed and WordEmbed need to know just 
what insertion point in the document the locator 
refers to. For example, they need to know if 

Figure 4  Defining locators with DEXembed

Figure 5 A Word document with DEXembed’s temporary paragraph 
numbers 
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Defining and using locators with WordEmbed 

WordEmbed uses a three-part click–copy–paste process 
(see Figure 6) to create a unique locator for each distinct 
location. Multiple index entries can use the same locator if 
they will be embedded at that same location.

1	 Click to the desired insertion point in your Word 
document. Create a temporary bookmark there, using 
a shortcut key combination defined in the WordEmbed 
user manual.

2	 WordEmbed copies the temporary bookmark number 
created (in Figure 6 for example it is 4.210) to the  
clipboard.

3	 Toggle to your C/M/S program and use the Paste command 
to copy the temporary bookmark number into the index 
entry’s locator field.

Differences between the two approaches 

DEXembed adds all the temporary locators to the Word 
document before indexing begins. These locators are on 
display in the Word document during the indexing process 
(Figure 5). The precision of index entry placement depends 
on the locator selected.
	 WordEmbed creates locators individually as needed, 
on demand. While multiple index entries can reuse the 
same bookmark number, each new embedded index entry 
location requires another application of the click–copy–

paste process (Figure 6). Locator creation (in the form 
of temporary bookmarks) is ongoing throughout the 
indexing process.
  Apart from this difference in locator assignment, the 
remaining steps are similar for the two utilities.

Step 2: Save index files for import

Once the index is finalized and ready for import into 
Word, save the index in the format needed based on 
which C/M/S program was used and which utility you 
are using.

Saving the index as a tab-delimited file for import into 
DEXembed

DEXembed requires a tab-delimited file as input 
into its import process. All C/M/S programs have the 
option to save indexes as tab-delimited files (in either 
DAT format or TXT format). Figure 7 shows the DAT 
format saved from my CINDEX program. Notice the 
tab characters between the various fields.  

Saving the index as a RTF (CMS) or MBK file for import 
into WordEmbed

WordEmbed (Figure 8) requires either an RTF file 
(available from all C/M/S programs) or an MBK file 
(available as a Macrex option) as input into its import 
process.

a ‘2’ in the locator field means ‘page’ 2, ‘paragraph’ 2 or 
‘bookmark’ 2. Before indexing begins, these associations 
need to be defined.

Defining and using locators with DEXembed 

Locators can be defined as any of the options in the 
DEXembed Options box (see Figure 4). The steps involved 
in defining locators with DEXembed (shown in Figure 4) 
are always completed prior to starting indexing:

1	 Select the Add-Ins tab from the Word ribbon (see Figure 
5).

2	 From the DEXembed dropdown menu, select Set 
DEXembed Options.

3.	 The DEXembed Options dialog box displays (Figure 4).
4	 Select the option desired (typically paragraph number).
5	 From the Add-ins tab on the DEXembed dropdown 

menu, select the Prepare Document dropdown menu, 
then the Add Paragraph Numbers option (Figure 5).

6	 DEXembed will then generate temporary paragraph 
numbers in the open Word document.

7	 The indexer uses these numbers as locators.

Figure 5 shows the Word document after DEXembed has 
added the temporary paragraph numbers (at the beginning 
of each new paragraph).

Figure 6 WordEmbed’s click–copy–past process

Figure 7  Saving the index in DEXembed 



117The Indexer Vol. 32 No. 3 September 2014

Haskins: DEXembed and WordEmbed

The DEXembed import and embedding process

To embed your index using DEXembed:

1	 Open the Word document.
2	� Open the tab-delimited file that contains the index 

entries.
3	� Set focus on the Word document (make sure it is active.)
4	� From the Word Add-ins tab, select the DEXembed 

dropdown menu.
5	� Select Embed from the Tab-delimited File option (Figure 

9).
6	� DEXembed processes behind the scenes and completes 

within a few minutes.

The WordEmbed import and embedding process

To embed your index using WordEmbed:

1	 Open the Word document.
2	� Open the tab-delimited file that contains the index 

entries.
3	� From the Word Add-ins tab, select the Embed Index 

button from the WordEmbed menu bar  
(Figure 10).       
4	� The Embed Index dialog box displays (Figure 

11).
5	 Select the format desired and click OK.
6	� WordEmbed processes behind the scenes 

and completes in a few minutes.

The embedded index in Microsoft Word after import 

Figure 12 shows the Word document containing 
the XE fields (index entries) after embedding 
has completed. It is always a sound practice to 
spot check the placement of index entries after 
the embedding process has completed.

Step 4: Remove the temporary locators

Once you are satisfied the import process 
embedded the index entries accurately, you 
can remove the temporary locators. Use the 
highlighted options for this step as displayed 
in Figure 13. This process works behind the 
scenes and takes less than a minute. Afterwards, 
spot check potential problem areas such as 
figure identifiers, notes sections and table cells 
to ensure the temporary identifiers have been 
removed.

Step 5: Generate the MS Word index 

�If you would like to see how the index looks with 
the newly embedded entries, generate the Word 
index by following Step 2, ‘Generating an index 
in MS Word (page 114).

Step 3. Import the index file into the Word document(s) and 
embed entries

This is where the magic happens! Once you invoke the 
‘embed’ (import) option, all processing occurs quickly 
(within minutes) behind the scenes and you have XE 
markers embedded in the Word document.

Figure 8  Saving the index in WordEmbed

Fgure 9 The DEXembed iport process

Figure 10  Selecting Embed Index in WordEmbed

Putnam
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Learning curves
Of course, there is a learning curve in mastering these two 
utilities. I think the most effort is involved in:

• 	familiarizing yourself with how DEXembed and 
WordEmbed work

• 	establishing new viable work processes
• 	a client version control system
• 	project prep work
•	 training your eye to ignore visual clutter in documents
• 	indexing and submitting one chapter at a time
• 	the final editing process.

Familiarizing yourself with how DEXembed and WordEmbed work 

The best way to learn something is just by doing. Both 
utilities have helpful tutorials and both have very helpful 
manuals. You might find it useful to create cheat sheets 
identifying shortcut keys. Document each step you need to 
take and exactly what you need to do in detail. It will save 
time particularly if you need to use the utility again after an 
extended period of time.
	 Start with a small project and give yourself plenty of time. 
You will be slow in your first few projects but your efficiency 
should increase dramatically as you gain expertise and a 
familiarity with the software and processes.

Establishing new viable work processes

In addition to the obvious time investment needed to learn 
the utilities, you might need to understand and adapt to 
new client processes. Unlike most back-of-book indexing 
projects where the final index is not submitted until all the 
manuscript pages have been indexed, some clients might 
want only one chapter at a time indexed, embedded in Word, 
and returned. Often deadlines are as little as a day, with final 
index edits performed at the tail end of the project.
	 Quick turnarounds and dealing with largely unedited 
and uncohesive index structures can make these projects  
unattractive for some indexers. It is important to recognize 
what process flow the client uses and decide whether it is 
compatible with your style.
	 Starting with a new client and a new process is always 
interesting. As you become familiar with the client needs, 
you find out if you already have a process in place that 
will work for this new client or if you will need to create a 
process. There will probably be a lot of give and take and 
experimentation until your new process is tweaked into 
place.

A client version control system

 If you have never worked with embedded indexing projects 
before, you are probably not familiar with the concept of 
the ‘hot potato’. Just consider the fact that you are using the 
client’s ‘live’ files – that hot potato – to embed your index 
entries into. You will not want anyone else modifying their 
copy of the files while you are working on them, since this 
would cause havoc with changes not recognized in the index. 

Figure 11 The Embed Index dialog box in 
WordEmbed 

Figure 12 The embedded index in Microsoft Word 

Figure 13  Removing the temporary locators 
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system. Document your processes in 
detail (again, this is particularly useful if 
you pick up these types of project after a 
long period away from them).

Training your eye to ignore visual clutter in 
documents

When I started these projects, I found 
it really difficult to wade through the 
rough, unformatted pages (see Figure 
14, right pane) and much too easy to 
lose my place. Then I discovered the 
Document Map (Figure 14, left pane). 
Navigating through it, I could tell at a 
glance what topics were covered, how 
they related to other, and how long each 
discussion was. If I lost my place or lost 
my train of thought, I could just revisit 

the Document Map and get a course correction.
  I also trained myself to ignore the visual clutter – the line/
paragraph numbers, instructions to the compositor, place-
holder notations – so I could concentrate on the content. 
This was much more difficult, but once I had managed it, life 
and indexing with Word documents became much easier.

Indexing and submitting one chapter at a time (for some clients)

I also found indexing one chapter at a time difficult initially 
because of how fragmented my indexing process became. 
Whereas I had always edited as I indexed, now I had 
reverted to a kitchen sink approach (throw everything into 
the index and sort it out later). It made me cringe every 
time I thought of the final edit step. I knew there had to be 
a better way, one that let me exert some vocabulary control 
over the separate indexes.

  I started to combine all the chapter 
indexes into one comprehensive index 
(for my personal use only). For this 
to work, I first had to manipulate the 
locator information because the indi-
vidual chapter-index line numbers would 
be meaningless once they were dumped 
into the composite index. How could I 
tell if locator ‘1’ was from Chapter 1 or 
from Chapter 2? I put the chapter number 
before each line number, and that kept 
the information unique and retrievable.
  Figure 15 displays my solution. It shows 
the boxes in both the current chapter file 
(on the left) and in the combined file (on 
the right).

The final edit process

When it came to the final index edit, I 
wanted to be able to edit with all the 
convenience of my indexing software. The 
problem was that my clients would just 
provide the final index in an RTF format 

That is why clients have version control systems. Make sure 
you find out your client’s procedures and guidelines. 
	 Make sure to identify the sign-out and check-in process 
for your files. The files might also need to be renamed 
once you have modified them. You will need to get all this  
information from the client.

Project prep work 

 It is always helpful to have a client sheet for each 
project, to identify client preferences regarding page range 
usage, insertion point restrictions, locator formatting guide-
lines, Word template usage, and naming conventions for 
updated documents. Again, create cheat sheets if your 
client uses unfamiliar commands in their version control 

Figure 14  Using the Word Document Map

Figure 15 Separate and combined chapters
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3	 Articles I have written and links to many other useful informa-
tion can be found on my website: http://luciehaskins.com/
resources.shtml.

4	 IndexDeconstructor was created and is maintained by Jack 
Lyon (www.editorium.com/indexdeconstructor.htm). It is 
available on a 45-day free trial basis for both Mac and Windows 
users. The single-user US purchase price (in 2014) is $29.95. 
A thorough and helpful user’s manual is provided with the 
product. Note that while IndexDeconstructor performs like a 
workhorse in converting indexes from RTF files to a format 
ready for importing to C/M/S packages, there is no free ride. 
There will always be some conversion difficulties, and some 
things will always need to be manipulated manually, but the 
conversions are much quicker than rekeying the index by hand.

Lucie Haskins became an indexer in 2000 after a long career in 
corporate America, with roles spanning the computer industry and 
management consulting. She specializes in embedded indexing and 
in computer- and business-related topics, and enjoys discovering 
and applying tools that optimize her indexing process. She believes 
strongly in giving back to a profession that has been so generous 
to her, and has presented workshops on various indexing topics, 
instructed for UC Berkeley’s online indexing course, and served ASI 
in chapter and national positions as well as on its webmaster team. 
Email: luciehaskins@gmail.com

which could not be inserted into my C/M/S program. The 
final index did not re-embed the index entries.
  My clients did not want me to re-embed my index edits 
back into the Word documents. They were using the embed-
ding only as a timesaver to allow indexing to occur much 
earlier in the production process. For that purpose it served 
its function well, but my indexes usually required a significant 
final edit in spite of my comprehensive index approach.
	 I discovered that IndexDeconstructor4 did exactly what  I 
needed. It massaged indexes in RTF format and output tab-
delimited files that were accepted as input into my C/M/S 
program. I was so delighted that I wrote an article for Key 
Words on it in 2010 (‘Demystifying IndexDeconstructor’ 
available on my website).

Conclusion: real world clients
Being able to use C/M/S software to provide a robust, well-
formatted index allows the indexer to concentrate on index 
content rather than index mechanics. And using DEXembed 
or WordEmbed to import that robust final index easily into 
Word documents further extends our efficient and effective 
use of time and tools.
	 The majority of my embedded indexing clients specialize 
in publishing computer books, something that has held true 
for the 14-plus years I have been indexing. However, with 
the growing popularity of digital publishing and ebooks, I 
can foresee other specialty areas growing interested in what 
embedded indexing has to offer.
	 Embedded indexing has always provided the ability for 
indexers to work from draft pages before pagination. Final 
pagination is irrelevant because as the pages reflow, the 
index entries (embedded right in the documents) reflow 
with them. It is not just in the computer industry that time 
has become more compressed. I think it’s imperative for 
today’s indexers, particularly those who plan to remain in 
this field for many years to come, to get a good working 
knowledge of and experience with embedded indexing.
	 Working with DEXembed or WordEmbed provides a new 
entrant into this subfield with a less expensive entry point 
and a shorter learning curve than working with the major 
DTP packages. It would be a good option to use one of 
these utilities as a springboard to more complex and involved 
embedded indexing packages such as FrameMaker and 
InDesign. So I believe many indexers will find DEXembed 
and WordEmbed to be essential parts of their toolkit.

Notes
1	 DEXembed was created and is maintained by Jack Lyon (www.

editorium.com/dexembed.htm). It is available on a 45-day free 
trial basis for both Mac and Windows users. The single-user 
US purchase price (in 2014) is $79.95. A thorough and helpful 
user’s manual is provided with the product.

2	 WordEmbed was created and is maintained in England by 
James A. Lamb (www.jalamb.com/wordembed.html). A demo 
version is available and supports Mac and Windows users. 
The single-user US purchase price (in 2014) is $130. The user 
manual is helpful and provides short tutorials on use with all 
three major indexing programs.
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